1. Summary

This document, besides exercises, contains details about the setup of the required software and the code
artefacts for Manipulating Models and Metamodels using a Model-Driven Approach using EMF and
Eclipse Framework in the Eclipse IDE as well as dealing with Sirius Visual Editors. The text is to be used
as a collection of practical examples to support the lab lectures of the course on Model-Driven
Engineering at Faculdade de Ciéncias e Tecnologia at Universidade Nova de Lisboa (FCT/UNL) in
Portugal.

2. Eclipse Setup

eclipseinstaller o oom:

type filter text

- Eclipse IDE for RCP and RAP Developer

A complete set of tools for developers who want to
create Eclipse plug-ins, Rich Client Applications or...
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’ Eclipse IDE for Scientific Computing

Toals for C, C++, Fortran, and UPC, including MPI,
OpenMP, OpenACC, a parallel debugger, and...

Eclipse IDE for Scout Developers

Eclipse Scout is a Java/HTMLS framework to develop
business applications that run on the desktop, on...
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Sirius 7.0

Sirius is an Eclipse project (http://www.eclipse.org/sirius) that allows you to easily create your own graphical modeling tools. It
2+' leverages the Eclipse modeling... more info

by Obeo, EPL
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bt pxDoc-Sirius Integration,... more info

by eXMS, EPL
document generator generation MSWord word documentation
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Excalibur

Marketplaces
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3. Creating my First Modelling Project

The first thing to do is to follow File->New->Ecore Modelling Project :

S eclipse-LectureNotes - Eclipse IDE

File Edit Navigate Search Project Run Window Help

New Alt+Shift+N & Modeling Project

Open File... % Ecore Modeling Project
. . . 9 Project
£4 Open Projects from File System... ) Create a new Modeling project to specify a domain model using the Ecore Language. |
Recent Files > @ Folder
T File
9 Representations File
= Example...
¢ Other... Ctrl+N
&1 Refresh F5
Convert Line Delimiters To >

Then introduce a name like, for instance, “HelloWorld”:

S New Ecore Modeling Project O X
Create a new Ecore Modeling project @

Enter a project name

Project name: HelchorId‘

B Use default location
C:\Users\vasco\edlipse-LectureNotes\HelloWorld Browse...
Working sets

[JAdd project to working sets New...

@ < Back Next > Cancel

Anariac X 10D

After pressing Finish whole set of files and folders will be automatically created:
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When navigating on the model explorer you will see the model folder, which is the place where you are
going to edit all the models and metamodels manipulation files. An empty helloWorld.ecore empty file was
created, and automatically the helloWolrd.aird is opened in the visual Diagram editor. You can start
immediately modelling your first metamodel with the Ecore UML-like Class models notation. You can
Model the following HelloWorld metamodel. By convention, you should always name the classes starting

with capital letters and the names of attributes should be started with a lower-case character.
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What we are saying here is that HelloWorld models have Hello’s and Worlds. Each instance of those

classes should have a name (or text, if you will) and a language. Each Hello is related to zero or more
worlds.

Now save everything you’'ve done so far (this should be a common procedure when you are dealing with
these tools to keep consistency as this automatically should synchronize/update with your ecore file).

The next thing to do is to try out some instances of this metamodel. So let us create an example model by
double-clicking on helloWorld.ecore file on the Model Explorer:

ile Edit Navigate Search Project Sample Ecore Editor Run Window Help

i FryO Q@ igd iRl il GvYy o v ABE
Model Explorer % I% 8T8 ahellowordd & helloWorld.ecore X
/pe filter text %~ & platform:/resource/HelloWorld/model/helloWorld.ecore
2 HelloWorld v # helloWorld
= Project Dependencies » B HelloWorldModel

» 1= src [in HelloWorld] > B Hello

> JRE System Library [jre] » B World

» B Plug-in Dependencies

» = META-INF

v = model

» 4 helloWorld.aird
~ &1 helloWorld.ecore
> # helloWorld
> [ helloWorld.genmodel

Outline > =g

1ere is no active editor that provides an outline.

If you don’t see the window like editor like the figure before, you can also right-click on the
helloWorld.ecore file and select Open With->Sample Reflective Ecore Model Editor like this:
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> [ helloWc Rename...
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B hellowe = Export.
Refresh
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>
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The next step is to create the model instances. For that, you need to right-click on the class
HelloWorldModel. It should be always the class that contains the other elements, also called root node (
and that usually, we name XXXModel to be clear). Select Create Dynamic Instance like in the following

figure:

‘helloWorld.ecore - Eclipse IDE

ample Ecore Editor Run  Window Help
rRreroryor|diEE

E% 1§78 aheloworld & hellov New Child

x & platform:/resource/| New Sibling
~ # helloWorld
> H HelloWorldMc¢
> H Hello
> B World # Cut

IE Copy

®  Delete
#  Find/Replace...

Validate
Live Validation

Control...

Wizards

>

ine. 5
Create Dynamic Instance...

© RunAs
*  Debug As
9 Profile As
Team
Compare With
Replace With
2 Show EClass information

= Show References

v v v

v

A dialogue box will appear asking for the name you want to persist the instance model you want to build
as an example. You can call here, for instance, HelloWorldExampleModel.xmi:
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orld/model/HelloWorldExampleModel.xmi - Eclipse IDE

Project Sample Reflective Editor Run Window Help
v B v v 1 foow v | =

o

5% f T8 axhelloWordd & helloWorld.ecore & HelloWorldExampleModel.xmi *
% @ 4 platform:/resource/HelloWorld/model/HelloWorldExampleModel.xmi
> # platform:/resource/HelloWorld/model/helloWorld.ecore

odel.xmi

Now you are able to add to the XMI file the instances in a explorer-tree-like fashion. Let us
create the following example:

e v o vy |PiEB
= B &%helloWorld & helloWorld.ecore & *HelloWorldExampleModelxmi *
»x v 4 platform:/resource/HelloWorld/model/HelloWorldExampleModel.xmi

— ~ 4 Hello World Model
+ Hello Ola
4 Hello Hallo
4 Hello Bonjour
+ World Mundo
+ World Welt
+ World Monde

> # platform:/resource/HelloWorld/model/helloWorld.ecore

@ Properties = [ Problems
Property Value
Language ‘=Portuguese
Name =0l
World =World Mundo

You can save it now. And that is it! You now have instances of your meta-model persisted in a XMi file.
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The next step is to make something with the instances.

Let us now translate the model instance to text, which is called model-to-text transformation. To do this we
will use Epsilon. More specifically, we will use the Epsilon Generation Language (EGL) language (for
more details about the language see the epsilon Book http://https://www.eclipse.org/epsilon/doc/book/ ).

For that, you have to create in the same model folder a EGL file. Just follow the sequence
File->New->Other:

B Model Explorer x 2% % 70 ahellowordd #® helloWorldecore % HelloWorldExam,
type filter text » v W platform:/resource/HelloWorld/model/HelloWorldExar
v @ HelloWorld v <4 Hello World Model
=i Project Dependencies * Hello Ola
> 1= sre [in HelloWorld] + Hello Hallo
> B JRE S New = Project.
: j‘“ :/Illg Go Into 2 File
» = ]
° ) 9 Folder
~ = moc Show In Alt+Shift+W >
. h & Copy Culsc @ Modeling Project relloWorld.eco
~ #@h
, 4 = Copy Qualified Name 0 Example...
> Bh B Paste Ctrl+V w  Other... Ctrl+N
s wy % Delete Delete
N
Build Path > New |
&= Outline % Move..
Trara i e & Rename... F2
&1 |mport...
i Export... ties % [Z Problems
Refresh F5
O Run As , erties available
% Debug As >

The next step is to look for egl:
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= Select a wizard O X

Select a wizard

Create a new EGL Template

Wizards:
| eg| x

~ & Epsilon
&) EGL Template
v = Examples
~ = Epsilon
1 Experiment with the different features of EGL using a Flowchart-to-HTML transformation.

7 Generating HTML pages from an XML document

® < tack Fish Concel |

Give a name to the file you want to store the egl code (e.g. generate-output.egl) and press Finish:

%= New EGL Program 0O X

New EGL Program

This wizard creates a new EGL program file with *.egl extension

Enter or select the parent folder:

HelloWorld/model

far

v & HelloWorld
= settings
2 bin
= META-INF
= model
&= src

File name: generatefoutpuﬂ

Advanced >>

@ < Back Next > Cancel

You can write the following code:
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& helloWorld  # helloWorld.ecore % HelloWorldExampleModel.xmi *generate-output.egl =
1 Internatiocnal

o
3

4 [% for (h in Hello.all) { %]
5 =>5>>>

6 [%=h.name%] [%=h.world.name}]
T <<<<<—

2 [%}%]

9

10 ——————————————————— — —

11

12 It seems to work!

Finally lets do the last steps to run it. Start by right-clicking on the egl file on the model explorer tree. Next,
follow Run As -> Run Configurations:

Imig BiHt~0 Q@ ~viqg > Bl - v o b w v|m

& Model Explorer x S% £ 78 ahelloworld & helloWorldecore & HelloWorldExampleModel.:
type filter text X % International
!
~ 1! HelloWorld
. New > .
= Project Depen 1 in Hello.all) { %]
» = src[in HelloW Show | Alt+Shift+W >
. ! ewin ' :3] [%=h.world%]
» = JRE System Lit
Open F3
> = Plug-in Deper ]
> = META-INF Open With >
~ & model = Copy Ctl+C T T
gelrlle;:{tei; 82 Copy Qualified Name &5 ekl
¢ P NeIOTONE g paste Ctrl+V
~ @ helloworld o .
> # helloWc eete elete
» ® helloWorld stalbetn >
> ¥ Helloworlc Move...
= Outline Rename... F2
&1 Import...
5 Export...
21 Refresh F5 Problems
4 Debug As > lable
€= Profile As >

Then double click EGL Generator:

14



| & Run Configurations

| Create, manage, and run configurations

i EREXIBY v

ype filter text]

B Acceleo Application
[& ECL Comparison

2 Edipse Application

| & EGL Generator

[# EMG Program

E1 EML Merging

£3 EOL Program

[ EPL Program

¥ Epsilon Flock Migration St
[# ETL Transformation
EVL Validation

Java Applet

Java Application

Ju JUnit

b Nham T T

<« I »

Filter matched 19 of 19 items

Configure launch settings from this dialog:

L - Press the 'New Configuration' button to create a configuration of the selected type.

[#" - Press the 'New Prototype’ button to create a launch configuration prototype of the selected type.

& - Press the 'Export’ button to export the selected configurations.
{2 - Press the 'Duplicate’ button to copy the selected configuration.
X - Press the 'Delete’ button to remove the selected configuration.

I’ - Press the ‘Filter' button to configure filtering options.

- Select launch configuration(s) and then select 'Link Prototype' menu item to link a prototype.
lu - Select launch configuration(s) and then select 'Unlink Prototype’ menu item to unlink a prototype.

- Select launch configuration(s) and then select ‘Reset w...ototype Values' menu item to reset with prototype values.

Edit or view an existing configuration by selecting it.

Configure launch perspective settings from the 'Perspectives' preference page.

)]

Run

Close

And you should see:
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S Run Configurations (] X
Create, manage, and run configurations @
Create a configuration to launch an EGL generator.
CReaxX[BV ~ Name: generate-output
type filter text & 5 = I
Template| & Models ®- Parameters| % Advanced = Generated Text| @ Profiling ) Common
B Acceleo Application s |
ource:
[4 ECL Comparison
/HelloWorld/model/generate-output.egl Browse Workspace...

2 Eclipse Application
~ @ EGL Generator
& generate-output
& EMG Program
£ EML Merging
3 EOL Program
[% EPL Program

¥ Epsilon Flock Migration Strategy

[% ETL Transformation
EVL Validation
Java Applet

Java Application

Ju JUnit

i JUnit Plug-in Test
@ Launch Group

4 OSGi Framework
L4 Pinset File

QVT Operational Transformation

4 I

Filter matched 20 of 20 items

O The console
O The following file:

Append to file

Trace:

[ Produce a trace model?

Text generated should be printed to:

Browse Workspace...

Browse Workspace...

Revert Apply

@

Select the Models tab and click on the “Add...” button, so that we can now associate the input instance

model so that the egl code can manipulate it:
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| & Run Configurations a X
| Create, manage, and run configurations ( !)

Create a configuration to launch an EGL generator.

BReEX BTV~ Name: generate-output

type filter text

& Template| & Models ®= Parameters #* Advanced [ Generated Text @ Profiling [ Common

B Acceleo Application

[4 ECL Comparison Add...
2 Edipse Application Edit..
~ & EGL Generator
Remove

&) generate-output
[% EMG Program Duplicate
[ EML Merging
2 EOL Program
[ EPL Program
¥ Epsilon Flock Migration Strategy
| [# ETL Transformation
EVL Validation
=i Java Applet
@ Java Application
Ju JUnit
i JUnit Plug-in Test
& Launch Group
4 OSGi Framework
[ Pinset File
QVT Operational Transformation

« NN ¢
Filter matched 20 of 20 items

Revert Apply

The next step is to select the option EMF Model:
| & Select type of model X L

Select type of model =

Select the type of model to add

& EMF Model

4 Registered EMF EPackage

& GraphML Muddle

¥ Plain XML Document

4. Simulink Model
EMicrosoft Excel Spreadsheet
 UML Model

(L] Show all model types

T
Give a name (e.g. firstTest) and then press the Browse Workspace for finding the input file, that in this
case we named it HelloWorldExampleModel.xmi . It will find by itself some metamodels. Remove them
and press “Add File...” and look for the helloWorld.ecore file (our metamodel). Before finishing unselect

17



the “Store on disposal’ checkbox to prevent that some wrong
HelloWorlExampleModel.xmi file. Everything should look like this:

% Configure EMF model
Configure EMF model

Configure the details of the EMF model

Identification

Name: firstTest

X

Aliases:

Performance

B Cache model elements to improve execution time
() Thread-safe cache

EMF

. Include external references
. Reuse unmodified file-based metamodels
[:] Validate model

Files/URIs

Model file: /HelloWorld/model/HelloWorldExampleModel. xmi

Browse Workspace...

Metamodels: | € /HelloWorld/model/helloWorld.ecore

Load/Store Options

Read on load: [ ]
Store on disposal: O

You just need to press “OK” then “Apply” and then

Hello World in the console:

oK

Add file...

Add URI...
Remove

Clear

Cancel

manipulation by egl can corrupt the

“‘Run”. The result should be your first Model-Driven
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=] eclipse-LectureNotes - HelloWorld/model/generate-output.egl - Eclipse IDE

File Edit Navigate Search Project Run Window Help

mihg H TRy gy L IS IR 2 - |

& Model Explorer * S5 f 0 ahelloWord & helloWorld.ecore & HelloWorldExample
% 1 International

type filter text

v 1 HelloWorld 3
=i Project Dependencies 4 [% for (h in Hello.all) { %]

> 1= src [in HelloWorld] 5 >35>
5 = -3 - 2

» 5 JRE System Library fre] 6 [%=h.name%] [%=h.world.name%]
T <L<L-

» = Plug-in Dependencies 8 [%)%]

» = META-INF 9

~ = model 0 ---———————————-

| generate-output.egl
» [ helloworld.aird
~ @1 helloworld.ecore

> & helloWorld
» & helloworld.genmodel D Properties [ Problems B Console *
> ¥ HelloWorldExampleModel.xmi Epsilon

12 It seems to work!

5 Outline ¥ 5% International
o Outline >« . se=s=- = __

—>>>>>

014 Mundo
L=

=222

Hallo Welt
L=

=
Bonjour Monde
L

It seems to work!

Congratulations!



